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1. Project Background 
 

The Amazon rainforest plays a critical role in regulating atmospheric levels of the greenhouse gas 

carbon dioxide (CO2), and hence the rate of global climate changes. The region also displays 

considerable spatial variation in forest structure and function from the slow-growing, long-lived forests 

of the lowland Amazon across to the highly dynamic ecosystems along the fertile Andes. An existing 

network focusing solely on measuring above-ground wood production across the region (RAINFOR) 

has provided key insights into the underlying processes controlling forest spatial heterogeneity and 

powerful evidence for concerted changes in forest processes across the region over the last few decades, 

likely driven by increases in atmospheric CO2 levels. However, without taking into account all key 

components of the ecosystem carbon (C) budget both above- and below-ground it remains unclear what 

any observed changes in stem growth mean for overall ecosystem C storage and release. For this reason 

the current project aims to dramatically enhance and extend the RAINFOR network by installing 

permanent sample lots across the Amazon where all key ecosystem C stocks and fluxes will be regularly 

monitored. This manual establishes a set of standardized methodologies to carry out this plot installation 

and subsequent monitoring. These protocols will be implemented across the Amazon by promising 

young South American scientists to provide baseline estimates of current forest C storage, and track 

ongoing changes in forest C cycling. This research will contribute to (1) local scientific capacity by 

training a large number of South American students in specialist ecological measurement and analysis 

techniques, and (2) the development of the next generation of coupled atmosphere-biosphere models that 

will play a key role in shaping international climate policy. 

 

2. Plot Selection & Establishment 
 

The pan-Amazon strategy within RAINFOR is to maintain sample forest plots across the edaphic range 

within each climatic zone and regional plot cluster. New plots should be randomly located within local, 

geomorphological strata that satisfy certain logistical criteria. New plots should (1) be on reasonably 

homogenous soil parent material and soil type, (2) have adequate access, (3) have sufficient long term 

security from human disturbance, and (4) have sufficient long term institutional support. However, in 

most Amazonian research sites, accurate habitat maps are lacking, which prohibits complete stratified 

sampling at large scales. Similarly at local scales, identifying geomorphological strata is difficult 

because no accurate soil maps exist. Satellite images help in identifying the range of vegetation types 

that might be found in any one area, but problems with the scale of resolution and lack of ground-

truthing limit the ability to accurately predict the exact distribution. Information from local residents and 

botanists who know the area can be very useful. Logistical constraints are also important: it is 

impractical to locate a plot greater than 1 hour from the field base, and it can be difficult to fit a 1 

hectare plot into a forest that is dissected by tracks. 

Within strata, plots should be randomly located, to avoid ‘majestic forest’ bias. If maps are available, 

plot location should be randomly assigned prior to going to the field. If not, in the field, there may be a 

tendency to establish the plot in particularly ‘good’ forest. If maps are available, the position of the plot 

starting point can be randomized by locating it in a random direction at a random distance >20m (i.e. out 

of sight), of the original, potentially ‘biased’ starting point. N/S and E/W directions for the principal 

axes of the plot are the most convenient but the eccentricities of the local strata may prevent this. The 

bearings of the main axis, and the latitude, longitude and elevation of the centre of the plot should be 

recorded. It is important to maintain homogeneity within the plot, so the shape of the geomorphological 

strata is an important consideration. Square plots have a lower edge : area ratio than rectangular plots, so 

have fewer problems with decisions concerning the presence of trees in or outside the plot at the edges.  
The coefficient of variation of basal area only really increases as sample plot size falls below ~ 0.4 ha. 
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Therefore, a plot size of 1 hectare is commonly chosen because it is greater than the scale of typical tree 

fall events, but sufficiently small to sample individual soil types.  
 

3. Above-Ground Carbon Stocks & Fluxes 

 
3.1. Foliage Density 

 

3.1.1. Leaf Area Index 

 

3.1.1.1. Equipment 

 

Nikon 980/990/995 digital camera, Nikon fc-e8/fc-e9 fish-eye lens, robust tripod, camera memory card 

reader. These cameras and lenses are out of production but can be sourced relatively easily at online 

stores (e.g.: www.amazon.com, www.ebay.com). 

 

3.1.1.2. Sampling Strategy 

 

LAI will be estimated by collecting color images of the canopy every month with a digital camera set to 

automatic connected to a hemispherical lens on a tripod at 20 points per hectare plot (20m separation 

distance between measurement points. When taking the photographs it is important that (1) direct 

radiation is low, so either when the sky is overcast with clouds or at sunrise or sunset, (2) the lens is 

pointing directly upwards (a building level may be used modify the tripod to ensure that the camera is 

level, alternatively leveled posts may be permanently installed at each measurement point, so that 

repeated tripod adjustment is not required), and (3) all photographs are taken in the same direction (e.g.: 

directly north). Image files should be given an appropriate name (date, time, site, plot, point number). 

These images may then be processed with image analysis software to estimate LAI (see Section 3.1.1.4 

Image Processing). 

 

3.1.1.3. Camera Settings & Downloading Images 

 

To select the correct lens for the camera: switch the top dial to M-REC (M = manual, A = automatic), 

then press MENU, select LENS and then FISHEYE. To select the correct image size and quality, switch 

the top dial to A-REC, press QUAL until the resolution visible in the lower left-hand of the screen is 

FINE. Now press QUAL and at the same time turn the dial until the image size (also visible in the lower 

portion of the screen) changes to 3:2. With this combination of image resolution and size it should be 

possible for the memory card to store 69 images at a time.  

To download the images, take out the memory card, insert into a card reader and connect to a 

computer. Place images from different sampling plots and sampling dates in separate files. Note the date 

and plot linked with each image name. 

 

3.1.1.4. Image Processing 

 

For image processing it is best to use the fastest computer you can get access to. Images may be 

processed with CAN-EYE free software (http://147.100.66.194/can_eye/page3.htm). Download the 

software from the web-page, and install the MCR installer first. At this stage the installation may request 

an update for a Microsoft Windows component. Navigate to the official Windows webpage to find and 

download this component.  

CAN-EYE analyzes 20 images at a time, so place all the images collected each month and plot in 

separate files, so that the images collected at the same place and time will be analyzed together (i.e.: all 
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the images from one plot taken in one month). The entire file address must not have any spaces (e.g.: 

C:\\1)Leafareaindex\Images\PlotA\December2009). 

Click on the CAN-EYE icon in the downloaded file, then select the CAN-EYE Hem option in the 

opening screen. Select the file which contains the images which you wish to analyze, then press OK on 

the parameterization page. The software now uploads the selected images, if they appear correct then 

press OK (otherwise you may select images to discard). On the next screen you may vary image contrast 

to optimum levels with the Gamma option and use Mask to exclude parts of the image which should not 

be analyzed. When finished, press Done. You now have to select how to distinguish vegetation from 

sky, select the option Select pixels corresponding to vegetation and continue.  

The software now reduces the image colour range to just 356 colours, all of which are represented as 

individual pixels in the box on the right side of the classification screen. To start, click the circle to the 

left of the Green veg box in the lower right of the screen. Click Yes for an automatic pre-selection of 

colours in the images which represent vegetation. All the colour pixels which have been classified as 

vegetation will fall to the bottom of the right hand box. To continue the classification process, left-click 

in the circle to the left of the Green veg box in the lower right of the screen, and left-click on any of the 

colours in the box which you think represent vegetation (rather than sky). To help you, colours which 

occur commonly and very commonly in the images are highlighted in the right-hand box with white and 

red dots respectively. When you have selected your chosen colours, right-click outside of the box to 

reclassify the images based upon your new selection. Repeat this classification process until you are 

satisfied that all vegetation has been successfully classified in the images, then click Done. After some 

time you will be given the option to exit the software. 

To check results of the analysis, open the output file saved in the same file as the analyzed images. 

Open the webpage entitled CEResults_whatever the filename is. This summarizes key values and 

graphics from the analysis. The output presents three types of LAI estimate: effective LAI for the (1) 

entirety of the image (effective LAI) and (2) only from the 57.5 view angle in the hemispherical images 

(effective LAI (57.5)), and (3) True LAI. Types 1 and 2 do not incorporate an estimate of the degree of 

canopy clumping and therefore underestimate the real quantity of LAI. Though LAI estimated at a 57.5 

view angle should be relatively insensitive to the extent of clumping within the images. Type 3 uses a 

clumping estimate for each image to derive a more accurate estimate of LAI. None of these estimates, 

however, distinguish the amount of area occupied in the images by non-photosynthetic material (trunks, 

branches), so some researchers chose to refer to these estimates instead as Plant Area Index (PAI).  

 

3.1.2. Specific Leaf Area 

 

3.1.2.1.  Equipment 

 

Digital camera and tripod or scanner, clear glass or Perspex sheets, measuring ruler, drying oven, paper 

bags, weighing balance (0.01g resolution). 

 

3.1.2.2. Sampling Strategy 

 

Leaves collected from the 11 evenly numbered litter fall traps (there are 25 litter fall traps in total per 

plot, see section on litter fall, below) should be collected, and stored in plastic bags to avoid desiccation, 

to calculate SLA. Images of the leaves need to be taken, either with a digital camera or scanner. The 

digital camera approach is more versatile in field situations while images captured with a scanner 

require much less time for image processing (see below). Both methods will be described.  

 Separate leaves from the rest of the organic material collected in the litter traps. If using a scanner, 

scan the leaves (color Jpeg, 200 dpi). If using a camera system, first place all the leaf material from each 

plastic bag onto a clear white paper sheet together with a label (site, plot, date, point) and a measuring 

ruler as a scale. Position the camera above the leaves with a tripod, then take a color, high resolution 
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picture of the leaves (from not more than 0.5m distance), making sure that you include the label and 

ruler, and save the image in Jpeg. file format. Save the scanned or photographed images with suitable 

names (site_plot_date_point) in a designated file. If several scans/photographs are required to capture all 

the leaves from a single point, these different images may be distinguished with letters after the 

measurement point number. Leaf area for each image may be calculated with image analysis software 

(see Section 3.1.2.3 below). 

All the leaf samples from each point should now be transferred to a paper bag (one per point), dried 

at around 50 
o
C to constant mass and weighed (along with all the other litter samples). Once dried, the 

dry mass of the leaf material collected at each of the 25 measurement points per plot should be entered 

into a datasheet. After weighing, all the dried leaf material should be placed back into their respective 

paper bags. Bags from a single sample period and plot should be placed into two plastic bags, 

compressed to remove excess air and sealed. The outer plastic bag should be marked with measurement 

type (e.g.: specific leaf area) sample date and plot. After this the samples may be placed in a safe, cool, 

dry place for long term storage (in the case of later data loss, possibility of chemical analysis of 

samples). SLA is calculated as total one-sided leaf area divided by total dry mass per point. 

 

3.1.2.3. Image processing 

 

Leaf area will be calculated with ImageJ freeware (http://rsb.info.nih.gov/ij/). The images are stored in a 

more versatile color Jpeg image format, but ImageJ only accepts grayscale images. So IrfanView 

freeware (http://www.irfanview.com/) is required to create grayscale copies of the original color images. 

First, open the Ifanview software and click on File -> Batch Conversion/Rename...Select the file which 

contains the color images to be analyzed (top left of the Batch Conversion window), and click Add all. 

Then select the output file (left of the Batch Conversion window) in which to place the grayscale 

images. To specify the desired conversion type, select the Use advanced options (for bulk resize...) 

window then click Advanced to open the advanced conversion window and select Convert to grayscale 

and OK.  

To begin image analysis with the grayscale images, open ImageJ and select File -> Open to select 

the desired image. To highlighted the desired portion of the selected image (the leaves), click on Image  

-> Adjust -> Threshold. Vary the two bars to accurately separate the leaves from the background, then 

press Set and OK. Now the scale of the image has to be set, to allow accurate area calculation. In the 

case of scanned images, the scale may be calculated directly from the dpi selected when scanning (dots 

or pixels per inch). For example, 200 dpi means that there are 200 pixels per inch in the image, or 78.74 

pixels per centimeter (since 1 inch = 2.54 centimeters). The relation between image pixels and real 

length is set in Analyze -> Set Scale. For a 200 dpi scanned image put 200 for Distance in Pixels and 

2.54 for Known Distance. For photographs the scale has to be re-set for every image (unless the camera 

is held static with a tripod, in which case the scale only has to be set the first time). To do this select the 

straight line drawing tool and trace a line along a known length of the measurement ruler in the image. 

Then navigate to the Set Scale window, the Distance in Pixels will already be set by the line, so you only 

have to enter the Known Distance in centimeters measured from the ruler in the image. This establishes 

a relation between the number of image pixels and the real length which enables accurate estimation of 

area in the image. To proceed with area measurement, use one of the selection tools (e.g.: Rectangular 

selection) to surround the objects of interest (the leaves), then select Analyze -> Analyze particles -> OK. 

Several output windows will be generated, the important one is the Summary window from which you 

can note the Total Area of the objects of interest. The Count may often be greater than the number of 

leaves in the image, this is usually because the areas of very small objects in the image are also included, 

but these should make very little difference to the overall area estimate. You can confirm this in the 

detailed Results window which presents area for every object identified in the selected region. 
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Repeat this process for all of the images. It is not necessary to set the scale for subsequent analyses if 

using a scanner, or if the camera was kept stationary. Total leaf area for each measurement point should 

be entered directly into a datasheet (where dry mass for the same points has already been entered). 

 

3.1.3. Canopy foliar mass 

 

CLM (t ha
-1

) can be calculated by multiplying mean plot LAI (m
2
 m

-2
) by LMA (g m

-2
), then dividing 

the sum by 100. Errors around the plot means of LAI and LMA may be propagated through to estimate 

errors around CLM values by quadrature of relative errors.  

 

3.2. Ground litter mass & litter production 

 

3.2.1. Ground fine litter mass 

 

3.2.1.1. Equipment  

 

Large paper bags, weighing balance (0.01g resolution), drying oven, 0.5 × 0.5 m wire square, knife.  

 

3.2.1.2. Sampling strategy 

 

Randomly place a 0.5 × 0.5 m square at 25 locations per plot (20 m separation distance between 

measurement points). Cut around the margins of the square, collect all the fine organic litter (not 

including branches > 2 cm diameter) within each square, and place within an appropriately named paper 

bag (site, plot, date, measurement point number). Do not include litter which is so decomposed that it is 

not readily identifiable as material derived from leaves, fruit, flowers, seeds or wood (i.e.: material that 

would be defined as humus). All the samples should be dried at around 50 
o
C to constant mass and 

weighed. Dry mass should be noted in a datasheet. Where a single piece of litter constitutes a 

disproportionately large proportion of the total weight (e.g.: a large seed, fruit), also note the individual 

weight of the piece in the observations column in the datasheet. 

 

3.2.2. Ground coarse litter mass 

 

3.2.2.1. Equipment 

 

Strong plastic string (800 m), diameter tape, marker tape, machetes, large canvas bags, large plastic 

bags, a hanging balance, graduated water flask.  

 

3.2.2.2. Sampling strategy 

 

Coarse litter is defined as all woody material over 2 cm diameter. Standing dead wood material should 

not be counted (this is separately quantified in Section 3.3: Stem biomass, growth & mortality). 

Establish 4 × 100 meter long transects within the plot (20 m separation distance between transects). 

Each transect should be 1 meter wide, with each edge marked with plastic string secured to the ground 

surface every 20 meters. Cut all the dead wood pieces (over 2 cm diameter) which intersect with the 

plastic strings, except for particularly large pieces of dead wood (which cannot be easily lifted) that 

should only be marked with marker tape. Record diameter and length (within the transect) of all wood 

pieces > 2cm diameter encountered, note separately measurements from the following diameter 

categories: 2-5 cm, 5-10cm, >10cm. Retrieve all the wood pieces which are small enough to easily lift, 

and place them in canvas bags. Use a separate canvas bag for each of 5 decomposition categories (see 

table below). When each bag becomes too heavy to easily carry along the transect, weigh the bag in situ 
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with the hanging balance. Note the weight of each bag, then empty the bags and spread out the wood 

material evenly within the plot, but outside of the transects. Continue this process of collection, 

weighing and bag emptying until all small wood pieces (which can be easily lifted) have been removed 

from the transects and weighed. There are thus potentially 15 categories which should be weighed 

separately (3 diameter categories × 5 decomposition categories = 15 categories). Save 30 wood pieces 

from each decomposition category and place in well sealed plastic bags (1 bag for each category).  

Finally, record length (within the transect), diameter and decomposition category of all of the large, 

marked wood pieces which remain on the transect. The values of both the mass of the small pieces in 

bags, and diameter of the individual large pieces should be stored in a datasheet.  

  

Decomposition 

Level 

Leaves 

present 

Fine twigs 

present 

Intact 

bark 

Firm 

wood 

Soft 

wood 

Very soft 

wood 

1 yes yes yes yes no no 

2 no no yes yes no no 

3 no no no yes no no 

4 no no no no yes no 

5 no no no no no yes 

 

3.2.2.3. Sample processing 
 

To derive estimates of coarse woody debris dry weight, the additional unwanted weight of the canvas 

bags and the water within the wood (for the small wood pieces) and wood density (for the larger pieces) 

needs to be calculated. Therefore, weigh (1) the canvas bags, and (2) each individual wood piece saved 

(5 decomposition categories, 30 per category, 5 × 30 = 150 total) before and after drying at around 50 
o
C 

to constant mass. Then place each wood piece into a graduated water flask half full with water and 

record (3) the volume of water displaced (remember 1 milliliter = 1 cm
2
). Pieces from decomposition 

categories 4 and 5 may need to be wrapped in Clingfilm before immersion to avoid saturation of 

airspaces within the wood (which would then lead to an underestimation of wood volume). These 

measurements should also be noted in the same datasheet, as wood mass and diameter. Wood density 

may be calculated as wood dry mass divided by volume. The volume of the larger wood pieces which 

could not be removed from the transects may be estimated from the equation for a cylinder: 3.142 × 

(diameter / 2) 
2 

× length. Mean wood density for the appropriate decomposition category, multiplied by 

the piece volume, gives an estimate of dry mass of each large wood piece. Total coarse litter mass per 

unit ground area may be calculated as the sum of all the weighed bags (minus the weight of water in the 

wood and the bags themselves) and the larger wood pieces which could not be removed from the 

transects. 

Diameter and length measurements of each wood piece may be used to calculate surface area with: 

(2 × 3.142 × ((diameter / 2) 
2
)) + (2 × 3.142 × (diameter / 2) × length). The sum of the surface areas of 

the pieces encountered gives an estimate of coarse litter surface area per unit ground area. This value, 

together with coarse litter respiration estimates (see Section 4.2.4 Coarse litter respiration), allows 

estimation of stand scale CO2 efflux from coarse litter on the ground. 

 

3.2.3. Fine litter fall 

 

3.2.3.1. Equipment  

  

One meter tall metal or plastic frames, plastic or wire 0.5 × 0.5 m squares which fit onto the top of the 

frames, fine mesh which can be secured around the squares, paper bags, tweezers, brushes, weighing 

balance (0.01g resolution). 
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3.2.3.2. Sampling strategy 

 

Fine litter is defined as all organic litter, but including only woody material less than 2 cm diameter. 

Litter traps, consisting of a frame that supports a 0.5 × 0.5 m square mesh net 1m above the ground 

surface, will be used to catch fine litter fall before it reaches the ground. Woody material over 2 cm 

diameter which enters the traps should be removed and spread around the plot. Twenty-five of these 

traps should be installed in each hectare plot (20 m separation distance between traps). Litter will be 

collected every 15 days and placed into sensibly identified paper bags (site, plot, date, trap number) for 

further processing.  

 

3.2.3.3. Sample processing 
 

Once collected, leaves from evenly numbered litter traps should be immediately separated whilst still 

wet to determine SLA (see Section 3.1.2 Specific Leaf Area). The rest of the litter should be dried at 

around 50 
o
C to constant mass (should take around 24 hours) as soon as possible (within 48 hours) to 

prevent decomposition. Once dried, litter should be separated into (1) leaves, (2) woody material, (3) 

fruits, (4) flowers, (5) seeds and (6) unidentified material, weighed and afterwards placed into 

appropriately named (site, plot, date, site, trap number, type of litter) paper bags for storage. Dry weight 

of the litter should be noted in an appropriate datasheet. A critical consideration with litter separation is 

to calculate the amount of time available to separate all litter before even more is collected, and modify 

the separation rate accordingly. Otherwise, the rate of litter separation may lag far behind litter 

collection, leading to massive accumulation of unprocessed samples and increased risks of sample loss 

and/or degradation.  

 

3.2.4. Coarse litter fall 

 

3.2.4.1. Equipment 

 

Diameter tape, marker tape, machetes, large canvas bags, large plastic bags, a hanging balance.  

 

3.2.4.2. Sampling strategy 

 

Coarse litter is defined as all woody material over 2 cm diameter, and should collected every 2 months 

from within the 4 × 100 m long transects initially used for sampling ground coarse litter mass. Only 

material fallen from live trees should be collected (data on fallen trees or material falling from dead 

trees will be included in Section 3.3 Stem biomass, growth & mortality). Cut all the dead wood pieces 

(over 2 cm diameter) which intersect with the plastic strings, except for particularly large pieces of dead 

wood (which cannot be easily lifted) that should only be marked with marker tape. There should be very 

few wood pieces which fall from live trees that cannot be easily lifted. Ignore large dead wood pieces 

that were marked in the initial survey. Retrieve all the wood pieces which are small enough to easily lift, 

and place them in canvas bags. You do not need to separate the pieces by decomposition category. 

When each bag becomes too heavy to easily carry along the transect, weigh the bag in situ with the 

hanging balance. Note the weight of each bag, then empty the bags and spread out the wood material 

evenly within the plot, but outside of the transects. Continue this process of collection, weighing and 

bag emptying until all small wood pieces (which can be easily lifted) have been removed from the 

transects and weighed. Finally, record diameter and decomposition category of all of the large, recently 

marked wood pieces which remain on the transect. The values of both the mass of the small pieces in 

bags, and diameter of the individual large pieces should be stored in a datasheet. 

 

3.2.4.3. Sampling processing 
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To derive estimates of coarse litter fall dry weight, the additional unwanted weight of the canvas bags 

and the water within the wood needs to be calculated. Wood density estimates are already available from 

activities described in Section 3.2.2 Ground coarse litter mass, while monthly mean wood water 

content will be calculated from activities detailed in Section 4.2.4 Coarse litter respiration. Therefore, 

only note the weight of the canvas bags in a datasheet. 

 

3.3. Stem biomass, growth & mortality 

 

3.3.1. Stems over 10 cm diameter 

 

3.3.1.1. Equipment 

 

Diameter tape, 1.3m long pole, ladder, calipers, Relaskop surveyor, dendrometer material (plastic strips, 

metal fasteners, and dendrometer pliers) 

 

3.3.1.2. Initial tree marking 

 

All trees and lianas (live and dead) over 10 cm diameter at 1.3 m height above the ground should be 

marked with aluminum plaques. The plaques should be engraved with numbers to uniquely identify each 

stem. To mark each stem secure the plaque with an aluminum nail inserted just far enough so that it 

penetrates the bark and is secure but leaving as much space as possible between the bark surface and the 

plaque. Place all plaques at 1.60m, and consistently on the same side of the trees throughout the plot. In 

square, 100 x 100 m plots it is useful to tag each successive row of 10 x 10 m subplots on a different 

side of the tree, as this helps identify where the internal lines of the plot are on subsequent occasions. 

Iron nails are required for the trees with the hardest wood. Be aware that (1) Newly broken or deciduous 

trees can be completely leafless so check carefully (e.g.: cut the tree bark to see if the cambium is alive); 

(2) Multiple-stemmed trees are tagged only on the largest stem that is >10cm diameter at 1.30m height. 

If two stems of the same species are very close together, check the roots carefully to see if the stems join 

below-ground; (3) Fallen trees should be checked carefully to see if they are still alive. They should be 

tagged 1.60m from the tree base; (4) Tag each liana stem that is >10cm diameter at any point within 

2.5m of the ground even if < 10cm at 1.30m. Check carefully as they can be easy to miss. Each climbing 

liana stem that meets this criterion and is separately rooted counts as one individual plant (but check 

carefully to see that the point where the stem meets the ground is actually rooted and not simply covered 

by leaf litter).  

 

3.3.1.3. Diameter measurements & dendrometer installation 

 

All live trees and lianas over 10cm diameter at 1.3 m height (but see unusual trees & lianas, below) 

above the ground should have dendrometers installed. Diameter increment should be recorded from 

these dendrometers every 3 months. Every year a new plot census should be conducted to incorporate 

new recruits into the survey. Measure initial diameter and install dendrometers at 1.3 m height wherever 

possible. If 1.3 m is not used as the point of measurement (POM), record the alternative height of the 

POM. To define the POM, use a pole with 1.3 m marked and pushed firmly into the leaf litter to the 

mineral soil next to the tree. Note the following information for each individual tagged (in the datasheet 

2) Stem dynamics / 2a) Stems > 10cm DBH): (1) initial diameter at POM, (2) subsequent incremental 

diameter expansion measured by the dendrometers. 

 

3.3.1.3.1. Normal trees 
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Before dendrometer installation clean loose bark and debris from the POM. The diameter measurement 

tape, and later the dendrometer, should be passed underneath vines and roots. Note that the ideal POM 

of 1.3 is not the vertical height above the ground, but is the straight line distance between the ground and 

the POM (these are the same distance on level ground, but will differ if the trees are leaning or the 

ground is sloped).  

 

3.3.1.3.2. Buttressed trees 

 

If the tree has a buttress which extends higher than 1.3 m, 

record initial diameter and install the dendrometer 50 cm above 

the top of the buttress (Condit 1998). Record POM height.  

 

3.3.1.3.3. Deformed trees 

 

If the tree has a major stem deformity at 1.3 m height, then record initial diameter and install the 

dendrometer 2 cm below the deformity (Condit 1998). Record POM height.  

 

3.3.1.3.4. Fluted trees 

 

If trees are fluted for their entire length (i.e.: at no point does the diameter remain constant with stem 

height), then record initial diameter and install the dendrometer at 1.3 m.  

 

3.3.1.3.5. Trees on slopes, leaning/bent trees 

 

Record initial diameter and install the dendrometer at 1.3 m 

from the downhill side of the tree. Trees that are bent or 

leaning should always be measured along the side of the 

stem closest to the ground. This procedure avoids 

confusion when trees are both on slopes and leaning.  

 

3.3.1.3.6. Stilt-rooted trees 

 

Individuals should have their initial diameter recorded, and the dendrometer installed, 50 cm above the 

highest stilt root. Record POM height.  

 

3.3.1.3.7. Re-sprouting trees 

 

Re-sprouting trees are only included if the sprouts are more that 1.3 m from the stem base. On standing, 

but broken trees, or fallen individuals, record initial diameter and install the dendrometer on both the 

main stem and the re-sprouts >10 cm diameter at 1.3 m from the base of the stem.  

 

3.3.1.3.8. Multiple stemmed trees 

 

Record initial diameter and install dendrometers on all stems >10cm at 1.3 m. 

 

3.3.1.3.9. Large trees 

 

Typically, large trees have buttresses which extend much higher than 1.3 m. In this case, use a ladder to 

record initial diameter and install the dendrometer 50 cm above the top of the buttress. Record POM 

height.  
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3.3.1.3.10. Normal lianas 

 

Any liana or hemi-epiphyte >10 cm diameter at any point along the stem between 0 and 2.5m above the 

ground should be included in the diameter survey. Each liana stem should have dendrometers installed 

and have initial diameter recorded at 3 different points: (1) 130 cm along the stem from the roots, (2) 

130 cm vertically above the ground, (3) at the widest point on the stem within 2.5m of the ground. 

Check carefully for the maximum diameter point, in lianas it is often close to the ground or a branching 

node where anomalous growth can be most marked. Describe the maximum diameter measurement 

point precisely in notes (e.g., ‘by ground’, ‘10cm above tag’ etc.).  

 

3.3.1.3.11. Cabled lianas 

 

Some lianas are composed of separate cables with the cables progressively splitting as the liana ages and 

each cable thickens; in these cases it is difficult to measure the liana in a way to permit long-term 

estimation of radial growth increments. For these lianas, diameter is estimated by tightening the 

diameter tape, and subsequently a dendrometer, around all adjacent cables originating from the same 

root base.  

 

3.3.1.3.12. Non-circular cross-section lianas 

 

Other lianas are clearly not circular in cross-section, these stems should be measured in two ways: 

conventionally (i.e. wrap the tape round the whole stem) and by twice measuring the linear distance of 

both the maximum and minimum dimension and taking the geometric mean.  

 

3.3.1.3.13. Branching lianas 

 

It can be difficult to decide where one liana ends and another starts. Lianas are sometimes connected to 

one another below ground but this can be hard to establish. Therefore, for ease of application we apply 

the criterion that any climbing stem that fully enters the mineral soil counts as an independent plant (an 

“apparent genet”). If unsure, then tag the stem and comment that it may be the same as another stem. In 

cases where the liana plant branches, each stem that branches within 2.5 m vertical distance from the 

ground and attains >10 cm maximum diameter is measured. In practice it is extremely rare for a 

branching liana to have two or more branches >10cm diameter (on average in Amazonia this occurs at a 

frequency of <0.1 per ha).  

 

3.3.1.4. Other measurements 

 

3.3.1.4.1. Trees 

 

In addition to diameter, for each tree marked, note in separate columns in a datasheet the following: (1) 

tag number, (2) POM height if not 1.3m, (3) genus, family and species, (4) approximate height, (5) 

approximate canopy diameter, (6) subplot number, (7) estimated X and Y co-ordinates from bottom left-

hand corner of plot, (8) bole form for live trees, using the following codes: normal (a), stem broken and 

resprouting, note height of break (b), stem leaning by ≥ 10 degrees (c), stem lying on ground (d), stem 

fluted and/or fenestrated (e), hollow stem (f), rotten stem (g), multiple stems, each stem > 99mm gets a 

number (h), no or few leaves (i), burnt stem (j), stem snapped < 1.3m (k), has liana > 10cm diameter on 

stem or canopy (l), >50% canopy covered by lianas (m), new stem (n), lightning damage (o), stem cut 

(p), has strangler (s), is a strangler (t), evidence of declining productivity/disease (z); (9) type of dead 

tree, using the following codes for mechanism of mortality: standing (a), snapped stem (b), uprooted (c), 
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standing/broken but probably standing (d), standing/broken but probably broken (e), standing/broken (f), 

broken/uprooted but probably uprooted (g), broken/uprooted but probably broken (h), anthropogenic (j), 

vanished, found location but not tree (k), presumed dead, location not found (l), burnt (n), lightning (o); 

(10) number of trees in mortality event, using the following codes: died solo (p), one of multiple deaths 

(q), not known; (11) killer tree or victim (killed by another tree), using the following codes: unknown 

(s), killer (t), killed, with no more information (u), killed by a tree that died broken (v), killed by an 

uprooted tree (w), killed by branches from a dead standing tree (x), killed by branches from a living tree 

(y), killed by strangler (z), killed by liana (2), killed by strangler/liana weight (tree died broken or 

fallen), use in combination with z and/or 2 (3), killed by strangler/liana competition (tree died standing), 

use in combination with z and/or 2; (12) cause of solo death, if known, using the following codes: 

diseased with insect infection (eD), by liana (eL), previous physical damage (eP), by strangler (eS), (13) 

decomposition status, using the following codes: intact (b1) where over 75% of the wood is still 

intact/hard often with fine branches/twigs attached, slightly damaged (b1.5) where bark may be 

damaged and the fine branches are usually absent but the heartwood is still present, damaged (b2) where 

fine branches are always absent and the wood has experienced some decomposition, quite rotten (b2.5) 

with little intact bark or branches and substantial decomposition of the wood, and rotten (b3) with little 

intact bark or branches and over 75% of wood made friable by decomposition.  

Note that these codes can be combined to describe multiple characteristics for a single individual. 

With multiple deaths the number of trees died should to be recorded. In the database this gets entered in 

the “comments” field. With broken trees the height at which the breakage occurred should be recorded. 

If liana(s)/strangler(s) were involved in killing the killer tree, then any trees which are in turn killed by 

the killer tree should be linked to the ultimate cause of death. For every tree which is killed this way we 

propose putting immediate risk of death first (e.g.: killed by uprooted tree) and the ultimate cause in 

brackets (e.g.: uprooted killer tree in turn killed by liana) 

 

3.3.1.4.2. Lianas 

 

In addition to diameter, for each liana marked, note in a datasheet the following: (1) tag number, (2) 

POM height if not 1.3m, (3) genus, family and species, (4) approximate height, (5) approximate canopy 

diameter, (6) subplot number, (7) estimated X and Y co-ordinates from bottom left-hand corner of plot, 

(8) number of the tree(s) which the liana is connected with, (9) tree number whose crown is most 

heavily affected by the liana, (10) whether they are alive or dead, then for dead lianas (11) type of dead 

liana, using the following codes: dead standing (a1), dead uprooted (a2), dead snapped (a3), (12) mode 

of death using the following codes: died solo, by itself (S), died solo and killed other trees/lianas (KO), 

killed by other tree/liana (OK), (13) cause of solo death, if known, using the following codes: diseased 

with insect infection (eD), by other liana (eL), previous physical damage (eP), by strangler (eS), (14) 

decomposition status, using the following codes: intact (b1) where over 75% of the wood is still 

intact/hard often with fine branches/twigs attached, slightly damaged (b1.5) where bark may be 

damaged and the fine branches are usually absent but the heartwood is still present, damaged (b2) here 

fine branches are always absent and the wood has experienced some decomposition, quite rotten (b2.5) 

with little intact bark or branches and substantial decomposition of the wood, and rotten (b3) with little 

intact bark or branches and over 75% of wood made friable by decomposition. 

 

3.3.2. Stems less than 10cm diameter 

 

3.3.3. Equipment 

 

1.3m long pole, calipers, water-proof red paint, measuring tape. 

 

3.3.4. Sampling strategy 
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Establish a 20 × 20 m subplot in the center of each plot. Mark all trees and lianas between 2 – 10cm 

diameter at 1.3m with waterproof red paint and note for every individual (1) diameter at the stem base 

and top and (2) height of every stem. Then, every 6 months, manually record stem diameter at the red 

mark with calipers. For unusually shaped lianas/trees follow the rules described above for tree above 

10cm diameter. Every year a new plot census should be conducted to incorporate new recruits into the 

survey. Record diameter at 1.3m and approximate height for all marked stems in a datasheet. 

 

4. Below-ground carbon stocks & fluxes 

 
4.1. Root biomass, growth & mortality 

 

4.1.1. Depth profile 

 

4.1.1.1. Equipment 

 

Spades, pick axes, large sieves, large canvas bags, saws, axes, wooden planks, nails, weighing balance 

(resolution = 0.01g), hanging balance. 

 

4.1.1.2. Sampling strategy 

 

Randomly select a 1m
2
 area within each plot. Remove the soil from the area in the following layers: 0-

10, 10-20, 20-30, 30-40, 40-50, 50-100, 100-150, 150-200, 200-250, 250-300, 300-350, 350-400 cm. 

For each layer, remove the roots with the sieves and separate into the following diameter classes: < 0.5, 

0.5-2, 2-5, 5-10, >10cm. Be extremely wary of portions of the hole collapsing whilst people are inside it. 

Construct wooden frames to reinforce the sides of the hole, and make sure than at least one person is 

present outside of the hole whilst anyone is inside. Place root samples from each diameter category into 

paper or canvas bags, dry at 50 
o
C until constant mass and weigh. Use a fine balance for small root 

samples, and a hanging balance for particularly heavy roots. Discard soil outside of the measurement 

plot. Cover the hole with a wooden frame covered in plastic and rope off the entire area with highly 

visible marker tape. Note dry mass of root samples collected in a datasheet.  

   

4.1.2. Surface root mass & growth 

 

4.1.2.1. Ingrowth cores 

 

4.1.2.1.1. Equipment 

 

Mesh (aperture diameter ~ 1cm), nylon fishing wire, strong scissors, post-hole digger, ruler, soil 

moisture and temperature sensors, timer, weighing balance (0.01g resolution), large plastic sheets, paper 

bags. 

 

4.1.2.1.2. Sampling strategy 

 

Remove 16 cores of soil (diameter ~ 14cm, depth ~ 30cm) per plot (30m separation distance) with a 

post-hole digger. Place each core on a plastic sheet in the field (or transport back to the field base in 

strong plastic bags) and manually remove the roots for a period of 40 minutes per sample but split the 

sampling period into 10 minute time-steps. Whilst processing each sample, try to keep sampling effort 

constant. For example, do not change the number of personnel halfway through processing a sample. 



 15 

Differences in sampling effort between samples are no problem, differences within samples should be 

minimised. The purpose of sampling by hand instead of using sieves is to avoid excessive alteration of 

soil texture. Splitting the sampling period into time steps allows estimation of the amount of root 

material remaining uncollected in the soil sample after 40 minutes. Place the roots collected from each 

time step into separate labelled paper bags (site, plot, date, sample number, time step), dry at 50 
o
C until 

constant mass and weigh. Sample dry mass from these first cores represents standing crop surface root 

mass, and should be entered into a spreadsheet 

Next, insert cylindrical mesh bags into the holes (made by rolling a section of mesh around a tube 

and securing with fishing line), and reinsert the root-free soil back into the holes from which they came. 

Place leaf litter to ambient levels onto the surface of the core once it has been reinstalled, to mimic field 

conditions. After an interval of approximately 3 months, record soil moisture and temperature within all 

of the cores, extract the mesh bags, and manually collect roots from the soil following the procedure 

described above to estimate root mass production over the 3 month interval. Note the root dry mass 

collected from each time step in a datasheet. Repeat this process every 3 months. 

 

4.1.2.1.3. Sample processing 

 

To estimate root mass that would have been collected if processing had continued beyond 40 minutes, 

use the following procedure. First, fit a curve (usually a power curve provides the best fit) through root 

mass removed over time for each core. Use the equation for the curve to estimate root mass collected 

over time after 40 minutes. Estimated mass collected will seldom reach absolute zero, in this case the 

cut-off point is where mass collected in a single time step < 1% of the cumulative total root mass already 

collected.  

 

4.1.2.2. Rhizotrons 

 

4.1.2.2.1. Equipment 

 

Metal or plastic rods, Perspex sheets (length = 27cm, width = 36cm), foam sheets, long nails, electric 

drill with screwdriver attachments, large plastic sheet, flat edged spade, broad hoe/pick axe, hammer, A4 

transparencies, permanent fine marker pens (black, blue, red, green), soil temperature and moisture 

sensors,  

 

4.1.2.2.2. Installation 

 

Ideally, installation should take place in the dry season otherwise high rainfall can soon erode the 

contact between the Perspex and soil. Excavate a 05 × 0.5 × 0.5m hole in the soil. Place all of the soil on 

a large plastic sheet. If there are distinct horizons in the soil keep soil from each horizon separate on the 

sheet. Cut one side of the hole to make it as flat as possible, using a flat-edged spade. Place the Perspex 

sheet on the flat side of the soil, secure to the soil by hammering the nails through the strengthening 

metal/plastic supports along the side of the screen and into the soil. Make sure that the top edge of the 

Perspex sheet remains level with the soil surface. Using the soil in the plastic bags, fill in the space 

between the Perspex and soil face. If there is soil in bags from different horizons, fill in soil to replicate 

the level of horizons present in the undisturbed soil. Use a rod to compact the soil to replicate density of 

undisturbed soil. Place the foam insulation next to the inside face of the rhizotron, and the plastic cover 

over the chamber. Minimize disturbance of the soil-Perspex interface: avoid compaction by roping off 

1m
2
 around the rhizotron, orientate the plastic rhizotron cover in a way that does not divert water onto 

the Perspex-soil interface, and ensure that the interface has leaf litter spread over it.  

 

4.1.2.2.3. Sample strategy 
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Rhizotron root length should be recorded monthly at 9 rhizotrons per plot (30 m separation distance) by 

placing a transparent A4 sheet over the Perspex face of the rhizotron and tracing visible roots using a 

fine permanent marker (see figure below). Each transparency should be marked with an identity code 

(site, plot, rhizotron number), and bars along the long edge to mark 10 and 20cm from the soil surface. 

Each root is divided into segments marked by crossbars. The segments correspond to the incremental 

increases in root length observed each recording session. Beside each traced root segment is noted the 

number of the recording session that the segment appeared, and the number of the session that the 

segment disappeared. Root diameter is indicated by colour (<1mm = black, 1-2mm = blue, 2-3mm = 

red, >4mm = green). Note that the majority of tracing will occur on session 1, after this only appearance 

of new roots, and growth and mortality of existing roots needs to be traced. Soil moisture and 

temperature should be recorded every session at the same point within 0.5 m of the rhizotron, but not 

near the Perspex-soil interface. If possible allow only one person to trace the roots, to avoid apparent 

changes in root dynamics due to changes between personnel.  

 

4.1.2.2.4. Sample processing 

 

Transparencies of root tracings from the rhizotrons 

should be scanned (colour scan, Jpeg file format, 150 

dpi) and saved in a file. It is not essential to scan the 

transparencies every session since the history of growth 

from all sessions is recorded in the transparencies 

themselves. We will use a method to convert the raw 

information recorded on the transparencies into root 

biomass per unit ground area (Bernier & Robitaille, 

Metcalfe et al. 2008). This conversion is extremely useful 

because it transforms root production and mortality into 

units which can easily be compared to other key 

ecosystem C fluxes, and it does not require any 

proprietary software. The only information required are 

(1) the number of independent roots contacting the 

rhizotron screen each measurement session, and (2) the 

diameter of each root contact. Do not include 

roots/segments which branch after contacting the 

rhizotron screen. Note these data in a spreadsheet. 

 

4.1.2.2.5. Data analysis 

 

These data may be used to calculate the total cross-sectional surface area of intersecting roots (XSr, 

mm
2
), using the following equation:  

 

2

142.3 22
r

XSr
Σ×

=  

 

Where r is root radius (mm), estimated as half of the diameter category (but 0.025mm for roots < 1mm, 

2.25mm for roots > 4mm). Using the product of equation 1, root production (Pr, t ha
-1

) for each 

rhizotron measurement session may be calculated as: 
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Where Fc is the soil coarse fraction, α is the angle of the rhizotron observation screen relative to the 

ground, γ is the ground angle relative to the horizontal, and W is the width of the rhizotron observation 

screen (mm). The 0.0003 value represents root density (g mm
-3

) necessary to convert root volume to 

mass. The 10
4
 value converts mm

2
 ground area into one hectare, and grams into tonnes. The additional 

multiplication factor of 2 is used because roots can only intersect with the rhizotron screen from the 

front. Thus it is assumed that if there was not an empty space behind the rhizotron screen to allow for 

measurement and observation then an equal amount of roots would intersect from behind as well as from 

the front. 

 

4.2. Respiration 

 

4.2.1. Using an infra-red gas analyzer 

 

An infra red gas analyzer (IRGA) records the rate of CO2 accumulation within a sealed chamber, to 

estimate CO2 efflux from whatever is enclosed within the chamber (whether it is a live tree stem, dead 

wood or soil). There are several commercially available systems but here we use the PP-Systems EGM-

4 and SRC-1 IRGA system because of its relative simplicity, portability and cheapness. To set up the 

machine, connect the “in” and “out” rubber tubes on the SRC-1 chamber to the corresponding ports on 

the EGM-4, connect the SRC-1 serial cable to the I/O port on the EGM-4, then switch on (switch at 

back). To make a measurement, press 1:REC -> 1:ALL -> 1:LINEAR. At the chamber volume menu 

press Y/R to accept the default chamber volume, but note the value (an equation exists to correct CO2 

efflux for changes in chamber volume, see Section 4.2.2.3 Chamber volume correction- so you can 

always apply this after measurements). At the Measurements setting menu press Y/R to accept the 

default value, then enter the measurement number. The chamber will then mix chamber and atmosphere 

gas for 15 seconds, during this period hold the chamber upwind and away from the body (to prevent 

contaminating the chamber gas with your exhalations). When mixing has finished, place the SRC-1 

chamber on tube which contains/is sealed onto the object of interest, and press Y/R. If the measurement 

appeared faulty during the measurement or after it can be cancelled and redone by pressing N at any 

time. This function can also be used to go back at any time if the wrong button was pressed by accident. 

Otherwise, after measurement press Y/R to record the measurement, and Y/R again to proceed to the next 

measurement. 

To transfer saved measurements to a computer, use a RS232 to USB converter to connect the RS232 

port on the EGM-4 to the computer. Be sure to install the necessary drivers for the converter first, and 

the EGM-4 Transfer software. Then switch on the EGM-4 and open the Transfer software. On the EGM-

4 press 4:DMP -> 2:DATA DUMP. In the Transfer software, press File -> Preferences -> Instrument 

Type -> EGM-4 and choose the correct Com Port where the USB converter is connected, then press 

Transfer -> Start. The software now requests that you select a location to save the data, select an 

appropriate file (specified in the sections below) then press Y/R on the EGM-4 to commence the data 

transfer. Open the saved file in Excel to verify that all the data has been transferred successfully. If the 

data transfer is not successful try again a few times, check the USB to Serial connection, try other USB 

to Serial converter cables, and/or try other Com Ports.  

Under default settings the EGM-4 will record each measurement for 120 seconds (= 24 records) or a 

change in chamber CO2 concentration of 50 ppm, whichever comes first. The EGM can store a 

maximum of 1000 records, therefore if flux rates are not unusually high so that every measurement 

proceeds for the full period of 120 seconds, a maximum of 41 measurements may be stored. If 

measurements proceed beyond this point the EGM-4 will begin to overwrite the oldest stored data. 
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4.2.2. Useful respiration equations 

 

4.2.2.1. Gram to µmol flux unit conversion 

 

The EGM-4 automatically calculates CO2 flux in units of g CO2 m
-2

 hr
-1 

(Unit 1), to convert to the more 

widely used unit of µmol m
-2

 s
-1

 (Unit 1) use the following simple relationship: 

 

Unit 2=Unit 1×6.312 

 

4.2.2.2. Soil/stem flux per unit area calculation 

 

However, while the automatically calculated values are a useful guide and should be manually noted at 

the time of measurements, they are calculated in a flawed way. Therefore, it is preferable to directly 

calculate fluxes from the raw data on the rate of increase in CO2 (ppm) per unit time (seconds). To do so 

take only the last 10 records of any individual measurement, verify that there is a steady, linear increase 

in CO2 over time, and use the following equation: 

 

Ruc=((C10- C1)/(T10 – T1))×(P/1000)×(273/(T+273))×(44.01/22.41)×(Vd/A)/1000×3600 

 

Where Ruc is respiration (g CO2 m
-2

 hr
-1

) assuming the default chamber volume setting (see chamber 

volume correction equation below), C10 and C1 are CO2 concentrations (ppm) at records 10 and 1 chosen 

respectively, T10 and T1 are the times (seconds) since that measurement began at records 10 and 1 

chosen respectively, P is atmospheric pressure (millibars, usually ~ 1013 at sea level), T is air 

temperature (
o
C), Vd is chamber volume (m

3
) at the default setting and A is tube area (m

2
) exposed to 

the soil/tree stem. 

 

4.2.2.3. Chamber volume correction 

 

All raw flux estimates usually need to be corrected for differences in chamber volume from the default 

setting. In the case of stem and soil respiration this is because of the additional volume of the tube 

sealing the chamber to the soil/stem. In the case of coarse litter respiration, the volume of the wood 

piece inside the tube should be subtracted from the tube volume. The volumes of both the tube and the 

wood pieces may be calculated from the equation for the volume of a cylinder (3.142 × radius
2
 × 

length). The equation to correct raw fluxes for changes in chamber volume is: 

 

Rc= Ruc×A/Vd×(Va+Vd)/A 

 

Where Rc is the respiration flux corrected for change in volume from the default setting respectively, 

and Va is the additional volume (m
3
).  

 

4.2.2.4. Coarse litter flux per unit mass/surface area calculation 

 

All of the respiration units presented thus far have been on a per unit ground/stem area basis, however, 

for coarse litter respiration measurements this is obviously not appropriate. Thus to calculate respiration 

per unit litter dry mass (Rlm, g CO2 kg litter
-1

 hr
-1

) and surface area (Rla, g CO2 m
-2

 litter hr
-1

) use the 

following equations: 

 

Rlm=Rc*(1/A)/Lm 

Rla=Rc*(1/A)/La 
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Where Lm and La are litter dry mass (kg) and surface area (m
2
) respectively. Measurements described in 

Section 4.2.4 Coarse litter respiration will allow estimation of dry mass and surface area of each wood 

piece sampled. 

 

4.2.3. Stem respiration 
 

4.2.3.1. Equipment 

 

Infra-red gas analyzer (IRGA) linked to a soil respiration chamber (SRC), plastic tube (diameter ~ 13cm, 

length ~ 3cm) which fits closely to the respiration chamber, modeling putty. 

 

4.2.3.2. Sampling strategy 

 

Select the tree closest to each of the 25 total soil respiration collars (see below) in each plot (20m 

separation distance). Each tree should have a diameter > 30cm at 1.3m and have relatively clean, smooth 

bark. Fix modeling putty along one edge of a plastic tube, and push this edge onto the stem surface at 

1.4m height. Ensure that the modeling putty completely seals the contact between the tube and stem. 

Now place the SRC firmly onto the tube, maintain pressure on the chamber and commence IRGA 

measurement using the procedure described above (Section 4.2.1 Using an infra-red gas analyzer). 

These measurements should be made every three months, synchronous with the dendrometer 

measurements. Make sure that you also note the identity of each tree, using the stem markers installed 

for dendrometer measurements (Section 3.3 Stem biomass, growth & mortality). Enter these 

measurements into a datasheet and save the raw EGM-4 output to a file. 

 

4.2.3.3. Sample processing 

 

Respiration measurements should provide a mean value for each plot of CO2 flux per unit area of stem 

surface. To derive a rough estimate of stand-scale stem respiration, per unit ground area, first calculate 

stem surface area for each individual tree (Astem, m
2
) with the following equation: 

 

Astem = 3.142*(Rb+Rt)*sqrt(Hs+((Rb-Rt)^2)) 

 

Where Rb and Rt are the estimated radii (m) at the base and top respectively of the individual stem, and 

Hs is estimated individual stem height (m). These data are gathered for each stem as part of the stem 

dynamics measurement protocol (Section 3.3 Stem biomass, growth & mortality). Then sum (1) the 

surface areas of every stem > 10cm DBH (Section 3.3.1 Stems over 10 cm diameter) and (2) 25 × the 

sum of surface areas for stems < 10cm measured in the 20 × 20m subplot (Section 3.3.2 Stems less than 

10cm diameter), gives estimated stem surface area per plot (per unit ground area). This does not include 

branch area, for which estimates of branch dry mass, maximum and minimum branch diameter are 

required. To calculate stand-scale stem respiration simply multiply the value of mean plot stem 

respiration per unit stem area by estimated total plot stem area. 

 

4.2.4. Coarse litter respiration 

 

4.2.4.1. Equipment 

  

IRGA and SRC, plastic tube (length ~ 5cm) which fits closely to the respiration chamber, plastic sheet, 

strong adhesive tape, calipers, weighing balance (0.01g resolution), drying oven 

 

4.2.4.2. Sampling strategy 
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Collect 5 representative wood pieces (~ 5cm long) of each decomposition category from each plot (5 

pieces per category × 5 categories = 25 pieces per plot), and place in appropriately marked sealed plastic 

bags (site, plot, date, piece number). Seal one side of a plastic tube with a plastic sheet secured with 

tape. Then place each individual piece of wood into the tube, place the SRC firmly onto the tube and 

commence IRGA measurement using the procedure described in Section 4.2.1 Using an infra-red gas 

analyzer. Now measure for each wood piece: (1) wet weight, (2) dry weight, after drying to constant 

mass at 50 
o
C, (3) diameter and (4) length. Ensure that the identity of each individual piece is noted, so 

that these measurements can be matched to the corresponding respiration value from the same piece. 

These measurements should be repeated every two months. Enter measurements into a datasheet and 

save the raw EGM-4 output to a file. 

 

Decomposition 

Level 

Leaves 

present 

Fine twigs 

present 

Intact 

bark 

Firm 

wood 

Soft 

wood 

Very soft 

wood 

1 yes yes yes yes no no 

2 no no yes yes no no 

3 no no no yes no no 

4 no no no no yes no 

5 no no no no no yes 

 

4.2.4.3. Sample processing 

 

The mean difference between wet and dry weight for each decomposition category will provide a wood 

moisture correction necessary for Section 3.2.4 Coarse litter fall. Estimate the surface area of each 

piece with the following equation: (2 × 3.142 × ((diameter / 2)
2
)) + (2 × 3.142 × (diameter / 2) × 

length). Dry weight and surface can then be used to calculate respiration per unit dry mass and surface 

area using the approach described in Section 4.2.2.4 Coarse litter flux per unit mass/surface area 

calculation. These values may be up-scaled to a stand scale estimate of CO2 flux per unit ground area 

using estimates of ground coarse litter mass and surface area from activities described in Section 3.2.2 

Ground coarse litter mass. 

 

4.2.5. Soil respiration 

 

4.2.5.1. Total soil respiration 

 

4.2.5.1.1. Equipment 

 

IRGA and SRC, plastic tubes (diameter ~ 13cm, 4cm length) which fit closely to the respiration 

chamber, measuring ruler, soil moisture and temperature sensor. 

 

4.2.5.1.2. Sampling strategy 

 

Insert 25 plastic tubes per plot (20m separation distance) into the soil such that ~ 1cm of each tube is in 

the soil. This ensures a close seal between each tube (which can be sealed to the SRC) and the soil, 

whilst minimizing soil and root disturbance. Record respiration with the IRGA and SRC system from 

each tube every month using the procedure described in Section 4.2.1 Using an infra-red gas analyzer. 

During the first measurement, record for each tube the height of the portion extending out of the soil (to 

calculate Va see Section 4.2.2.3 Chamber volume correction). After every respiration measurement, 

record soil moisture and temperature inside every tube. Enter these measurements into a datasheet and 

save the raw EGM-4 output to a file. 
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4.2.5.2. Partitioning components of soil respiration 

 

4.2.5.2.1. Equipment 

 

IRGA and SRC, plastic tubes (diameter ~ 13cm, per plot: 12 × 10 cm length, 24 × 40 cm length) which 

fit closely to the respiration chamber, post-hole digger, fine mesh, superglue 

 

4.2.5.2.2. Installation 

 

The partitioning experiment consists of 4 groups of 9 

tubes per plot (36 tubes in total per plot). Each tube 

within a group should be located 50cm from each other. 

Each group should be separated by 80m within each plot. 

Before tube installation, insert tubes (4cm length) to 

~1cm depth at all of the locations where the tubes will be 

installed, remove surface organic litter from inside each 

tube (place in a bag adjacent to each tube), leave them for 

a minimum of 5 hours to stabilize, then record respiration 

from all the tubes with the IRGA and SRC system using 

the procedure described in Section 4.2.1 Using an infra-

red gas analyzer. Afterwards place the surface organic 

litter back into their respective tubes. The purpose of this 

measurement is to estimate pre-existing spatial variation 

between tubes in a group. Enter these measurements into 

a datasheet and save the raw EGM-4 output to a file. 

 Now prepare the mesh tubes (row 2, tubes 2a-2c) by cutting three 3 × 3cm windows along two 

opposite sides of twelve 40cm long tubes (six 3 × 3cm windows on each tube). The upper rim of the first 

window should begin 5cm along the tube, each window should be separated by 5cm. Now cut the fine 

mesh into 5 × 5cm squares, line the perimeter of the windows in each plastic tube with superglue and 

place a fine mesh square onto the glue whilst still wet. Be careful that you do not accidentally glue other 

objects!! 

 Commence installation by removing surface organic litter at all locations along rows 2 (tubes 2a-2c) 

and 3 (tubes 3a-3c), and removing soil cores (~13 cm diameter, ~ 35 cm depth) with a post-hole digger, 

then place the soil from each core on a separate plastic sheet. If the soil has distinct horizons, keep soil 

from each horizon separate. Manually remove the majority of roots from the soil cores, these roots do 

not need to be weighed, the objective is simply to remove the majority of live organic material from the 

soil within these cores, dead organic material can remain in the soil. Insert the 40cm long tubes into the 

holes (mesh tubes along row 2, unmodified tubes along row 3), leaving ~5cm protruding out of the soil. 

Place the soil back into the holes, both inside and around the tubes, replicating the natural soil horizons 

and compacting the soil to similar levels as undisturbed soil. Be particularly careful with the mesh tubes 

(row 2) to (1) ensure that soil is contacting the mesh windows on both sides, and (2) the mesh windows 

are not broken (by, for example, protruding roots or over-compacted soil). If there is not sufficient soil 

to fill the tubes to the same level as the surrounding soil (or the gap between the tube and margin of the 

hole), gather extra root-free soil from outside of the plot. 

 Now replace ambient levels of surface organic matter onto tubes along column a (1a, 2a, 3a), then 2 

× ambient levels of organic litter on tubes along column c (1c, 2c, 3c). Tubes along column 2 remain 

without litter, but place within these tubes a level of gravel (~2cm depth) to maintain soil physical 

conditions. 
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4.2.5.2.3. Sampling strategy 

 

Record respiration with the IRGA and SRC system from each tube every month using the procedure 

described in Section 4.2.1 Using an infra-red gas analyzer). During the first measurement, record for 

each tube the height of the portion extending out of the soil (to calculate Va see Section 4.2.2.3 

Chamber volume correction). After every respiration measurement, record soil moisture and 

temperature inside every tube. Enter these measurements into a datasheet and save the raw EGM-4 

output to a file. 

 

4.2.5.2.4. Data analysis 

 

The partitioning experiment should allow estimation of the relative contributions of (1) surface organic 

litter, (2) roots, (3) mycorrhizae and (4) soil organic matter to total soil respiration. Contributions are 

estimated from differences between tubes subjected to different treatments, in excess of pre-existing 

spatial variation (NV). In addition, a separate experiment (Section 4.2.5.3 Control for partitioning 

experiment) quantifies the separate, unwanted, differences between tubes caused solely by the extra soil 

disturbance involved with installation of the deep soil cores.  

 

4.2.5.2.4.1. Litter respiration 

 

First calculate NV (proportion of ambient) for tubes from the two litter treatments (zero and double litter 

level) from the respiration measurements made on surface cores installed at all locations before tube 

installation: 

 

NV for zero litter = (column a – column b) / column a 

NV for double litter = (column c – column a) / column a 

 

After tube installation calculate litter respiration (proportion of ambient) in excess of NV from the 

measurements after tube installation with: 

 

Zero litter = NV value for zero litter – ((column a – column b) / column a) 

Double litter = NV value for double litter – ((column c – column a) / column a) 

 

Note that only matching tubes should be compared (e.g.: NV for zero litter on 1b = 1a – 1b / 1a). 

 

4.2.5.2.4.2. Root respiration 

 

First calculate NV (proportion of ambient) for the relevant tubes (rows 1 & 2) from the respiration 

measurements made on surface cores installed at all locations before tube installation: 

 

NV = (row 1 – row 2) / row 1 

 

Then, to remove any additional influence of the different levels of disturbance experienced by the soil in 

row 2 compared to the surface tubes of row 1, calculate mean respiration from disturbed (DCd) and 

undisturbed (DCud) deep cores (described in Section 4.2.5.3 Control for partitioning experiment). 

Finally to calculate root respiration (Rr, proportion of total ambient soil respiration) in excess of NV and 

controlling for tube installation disturbance from the measurements after tube installation use the 

following equation: 
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Rr = NV – ((row 1 – row 2) / row 1) × (DCud / DCd) 

 

Note that only matching tubes should be compared (e.g.: NV for tube 2a = 1a – 2a / 1a). 

 

4.2.5.2.4.3. Mycorrhizal respiration 

 

First calculate NV (proportion of ambient) for the relevant tubes (rows 2 & 3) from the respiration 

measurements made on surface cores installed at all locations before tube installation: 

 

NV = (row 2 – row 3) / row 1 

 

Now, to calculate mycorrhizal respiration (Rm, proportion of total ambient soil respiration) in excess of 

NV from the measurements after tube installation use the following equation: 

 

Rm = NV – ((row 2 – row 3) / row 1) 

 

Note that only matching tubes should be compared (e.g.: NV for tube 2a = 1a – 2a / 1a). 

 

4.2.5.2.4.4. Soil organic matter respiration 

 

First calculate NV (proportion of ambient) for the relevant tubes (rows 1 & 3) from the respiration 

measurements made on surface cores installed at all locations before tube installation: 

 

NV = row 3 / row 1 

 

Then, to remove any additional influence of the different levels of disturbance experienced by the soil in 

row 2 compared to the surface tubes of row 1, calculate mean respiration from disturbed (DCd) and 

undisturbed (DCud) deep cores (described in Section 4.2.5.3 Control for partitioning experiment). 

Finally to calculate soil organic matter respiration (Rsom, proportion of total ambient soil respiration) in 

excess of NV and controlling for tube installation disturbance from the measurements after tube 

installation use the following equation: 

 

Rsom = NV – (row 3 / row 1) × (DCud / DCd) 

 

4.2.5.3. Control for partitioning experiment 

 

The key advantage of the deep core insertion method chosen- extracting soil first and manually 

removing roots- is that there is no subsequent bias from decomposition of severed roots in the soil, as 

there would have been if the tubes had simply been directly inserted into the soil (the more obvious, 

common approach). However, the key problem with the method chosen here is that the soil disturbance 

associated with soil removal and manual mixing may alter subsequent CO2 fluxes. To quantify, and 

correct for, this artifact the following experiment is required.  

 

4.2.5.3.1. Equipment 

 

IRGA and SRC, plastic tubes (diameter ~ 13cm, 40 cm length) which fit closely to the respiration 

chamber, heavy metal hammer, post-hole digger, large plastic bags.  

 

4.2.5.3.2. Installation 
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In the center of each plot insert five 40cm long plastic tubes directly into the soil (leaving 5cm 

protruding out of the soil), using a heavy metal hammer. You will need to spread the impact of the 

hammer across the surface of the tube with a strong piece of flat wood. If you encounter a thick root, 

withdraw the core and try installation nearby. The tubes should be separated from each other by 

approximately 2m. Now excavate soil cores (~13 cm diameter, ~ 35 cm depth) about 5cm from each 

tube with a post-hole digger, place the extracted soil from each core on a separate plastic sheet. If the 

soil has distinct horizons, keep soil from each horizon separate. Manually mix the soil, but do not 

remove any roots, and place the soil back into the respective cores from which they were remove 

making sure that the soil density and horizons are as similar as possible to the ambient soil. If there is 

not sufficient soil to fill the tubes to the same level as the surrounding soil (or the gap between the tube 

and margin of the hole), gather extra root-free soil from outside of the plot. Finally, place within every 

tube a level of gravel (~2cm depth) to maintain soil physical conditions. 

 

4.2.5.3.3. Sampling strategy 

 

Record respiration with the IRGA and SRC system from each tube every month using the procedure 

described in Section 4.2.1 Using an infra-red gas analyzer. During the first measurement, record for 

each tube the height of the portion extending out of the soil (to calculate Va see Section 4.2.2.3 

Chamber volume correction). After every respiration measurement, record soil moisture and 

temperature inside every tube. Enter these measurements into a datasheet and save the raw EGM-4 

output to a file. 

 

4.2.5.3.4. Data analysis 

 

Calculate mean respiration from the disturbed (DCd) and undisturbed (DCud) deep cores. The 

proportional change in respiration attributable solely to soil disturbance may be quantified as: DCud / Cd. 


